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Safety and Compliance Information 

Conventions Used Symbol 

The symbols in this chapter are shown in the following table. They are used to remind the reader of 

the safety precautions during equipment installation and maintenance. 

Safety Symbol Description 

 
Generic alarm symbol: To suggest a general safety concern. 

 
ESD protection symbol: To suggest electrostatic-sensitive equipment. 

 
Electric shock symbol: To suggest a danger of high voltage.  

 

Safety Information 

 
WARNING! 

Installation and removal of the unit and its accessories must be carried out by qualified personnel. 
You must read all of the Safety Instructions supplied with your equipment before installation and 
operation. 

 

Warnings: 

 If the product does not work properly, please contact your dealer or the nearest service center. 

Never attempt to disassemble the camera yourself. (We shall not assume any responsibility for 

problems caused by unauthorized repair or maintenance.)  

 To reduce the risk of fire or electrical shock, do not expose this product to rain or moisture.  

 This installation should be made by a qualified service person and should conform to all the 

local codes.  

 Please make sure that the ceiling can support more than 50(N) Newton gravities if the camera is 

fixed to the ceiling.  

 Make sure the power supply voltage is correct before using the camera.  

 Do not drop the camera or subject it to physical shock.  

 Do not touch sensor modules with fingers. If cleaning is necessary, use a clean cloth with a bit of 

ethanol and wipe it gently. If the camera will not be used for an extended period of time, put on 

the lens cap to protect the sensor from dirt.   

 Do not aim the camera lens at the strong light such as sun or incandescent lamp. The strong 

light can cause fatal damage to the camera.  

 The sensor may be burned out by a laser beam, so when any laser equipment is being used, 

make sure that the surface of the sensor not be exposed to the laser beam.  

 While shipping, the camera should be packed in its original packing.  



 
Caution: Fiber optic ports – optical safety. 

 
Never look at the transmit laser while the power is on. Never look directly at the fiber ports and 
the fiber cable ends when they are powered on. 

Caution: Use of controls or adjustments to the performance or procedures other than those 
specified herein may result in hazardous laser emissions. 

 

Regulatory Compliance 

FCC Part 15 

This equipment has been tested and found to comply with the limits for digital device, pursuant to 

part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 

interference when the equipment is operated in a commercial environment. This equipment 

generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance 

with the instruction manual, may cause harmful interference to radio communications. Operation of 

this equipment in a residential area is likely to cause harmful interference in which case the user will 

be required to correct the interference at his own expense. 

This product complies with Part 15 of the FCC Rules. Operation is subject to the following two 

conditions: 

1. This device may not cause harmful interference.  

2. This device must accept any interference received, including interference that may cause 

undesired operation. 

LVD/EMC Directive 

 

This product complies with the European Low Voltage Directive 2006/95/EC and EMC Directive 

2004/108/EC.  

WEEE Directive–2002/96/EC 

 

The product this manual refers to is covered by the Waste Electrical & Electronic Equipment (WEEE) 

Directive and must be disposed of in a responsible manner. 



Preface 

Audience 

This manual is intended for: 

 Surveillance system planners 

 Field technical support and servicing engineers 

 Software installation, configuration, and servicing administrators 

 Product users 

Technical Support 

globalsupport@uniview.com 
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Thank you for purchasing our products. If there are any questions, or requests, please do not 
hesitate to contact the dealer. This manual applies to Network Camera. 

This manual may contain several technical incorrect places or printing errors, and the content is 
subject to change without notice. The updates will be added to the new version of this manual. We 
will readily improve or update the products or procedures described in the manual. 

1  System Options  

Item Requirements 

Operating 
System 

Microsoft Windows 8/Windows 7/Windows XP (32-bit or 64-bit).  

Microsoft Windows 7 is recommended. 

CPU 2.0 GHz or higher, dual-core. Intel i3 CPU or above is recommended. 

Memory At least 1 GB. 2 GB (or higher) is recommended. 

Graphic card 

At least 128 MB display memory.  Mainstream discrete graphics with more than 1 
GB display memory are recommended. The hardware should support DirectX9.0c. 

Note: Make sure that the latest driver is installed on the graphic card. 

Sound card 
Essential. 

Note: The intercom and voice broadcast require the latest driver on the sound card. 

Network card Gigabit (or higher) Ethernet network cards are recommended. 

Display 
definition 

 Least: 1024*768 

 Ideal: 1440*900 

Web Browser 
Internet Explorer 8.0 (or above) is recommended with the security level of 
Medium-high. 
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2  Network Setting 

This chapter introduces the basic network settings, including wired and wireless connections, which 
are fundamental to accessing the network camera (also named IP camera, abbr. IPC).  

Wired Connection 

Connecting to the Network over the LAN 

This part for setting IPC over the LAN mainly involves two procedures. One is cable connecting, 
which is the basic physical connection. And the other one comes detecting and changing the IP 
address, which secures reliable data stream flowing via relevant protocol.  

Cable Connecting 

The following figures provide two methods for connecting a network camera to a computer: Figure 
2-1 shows the direct connection to the computer, while Figure 2-2 indicates an indirect connection 
over the LAN via a switch or a router.  

Figure 2-1 Connect to Computer Directly 

 
 

Figure 2-2 Connect via a Switch or a Router 

 
 

Configuring the IP Address 

The IP address enables you to visit the network camera over the LAN. 

Steps: 

1. Get the current IP address of the camera through EZManager (Univew client software) based on 
is the information labeled on camera, such as device serial number, device version and etc. For 
detailed information, please refer to Detecting Devices Online. 

 NOTE! 

 The default IP address is “192.168.0.13”. Both the default username and password are “admin”.  

 This step is necessary only when the IP address is unknown. 

 

2. Change the IP address and the subnet mask to the same subnet as that of your computer under 
Setup > Basic > Network. For detailed information, please refer to Network. 

Network cable

IPC Computer

IPC Computer

Network cable Network cable
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 NOTE! 

 The camera will reboot after the IP address is changed.  

 You can also modify network settings via EZManager. Refer to Modifying Network Configuration for 
detailed information. 

 To access the network camera from a different subnet, please set the gateway for the network 
camera after you have logged in. 

 

Connecting to the Network over the WAN 

This part describes how to connect the network camera to the WAN with a static or a dynamic IP. 

Connecting Based on a Static IP  

To connect a Uniview network camera using a static IP address, you need to apply for a unique static 
IP from an ISP (Internet Service Provider) for the camera first, and then use this IP address to 
connect the network camera to the WAN directly or via a router. 

If you choose to connect the network camera to the WAN directly (shown as Figure 2-3), please refer 
to Configuring the IP Address for detailed information to set the obtained static IP in the camera. If 
you intend to connect the network camera to the WAN via a router (shown as Figure 2-4), you need 
to perform the following steps as required: 

1. Connect the network camera to the router.  

2. Set the LAN IP address, subnet mask and gateway in the camera. Please refer to Configuring the 
IP Address for more information.  

3. Set the obtained static IP in the router.  

4. Access the network camera through a web browser or the client software over the Internet. 

 

Figure 2-3 Connect the Camera to the WAN Directly 

 
 

Figure 2-4 Connect the Camera to the WAN via a Router 

 

 
 

Connecting Based on DHCP 

To use a dynamic IP address for the Uniview network camera, you need to apply for a dynamic IP 
from an ISP. With the dynamic IP address, you can connect the network camera to the WAN directly 
or via a router.  

The following describes the steps of connecting via a router. Step 2-3 can be eliminated if you select 
directly connecting. 

1. Connect the network camera to the router (shown as Figure 2-4).  

2. Access the router. 

3. Enable DHCP mode in the router to distribute dynamic IP.  

Network cable

IPC Computer

Network cable
WAN

Network cable

IPC Computer

Network cable Network cable

WAN
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4. Access the network camera. Please refer to Accessing the Network Camera for more 
information.  

5. Set IP Obtain Mode to DHCP under Setup > Basic > Network in the camera.  

6. Click OK at the bottom of the Network interface. 

7. Use the new IP address to access the camera. 

 

 NOTE! 

 The new network settings require a reboot to take effect. 

 For using DHCP mode, the IP address is dynamically assigned after rebooting, therefore, please 
refer to Detecting Devices Online to identify the new obtained IP address. 

 

Connecting Based on PPPoE 

To use PPPoE mode to connect the network camera to the WAN, you need to apply for a PPPoE 
account from an ISP first. With the PPPoE account, you can connect the camera to the WAN directly 
or via a router.  

The following describes the steps for a connection via a router. Step 2-3 can be eliminated if you 
select directly connecting. 

1. Connect the network camera to the router (shown as Figure 2-4).  

2. Access the router. 

3. Enable PPPoE mode in the router.  

4. Access the network camera.  Please refer to Accessing the Network Camera for more 
information.  

5. Set IP Obtain Mode to PPPoE under Setup>Basic>Network in the camera.  

6. Click OK at the bottom of the Network interface. 

7. Use the new IP address to access the camera. 

 NOTE! 

 The new network settings require a reboot to take effect.  

 For using PPPoE mode, the IP address is dynamically assigned after rebooting, therefore, please 
refer to Detecting Devices Online to identify the new obtained IP address. 

 

Wireless Connection 

For video surveillance applications, wireless technology enables a flexible, cost-efficient and quick 
way to implement monitoring, especially in the complex conditions where cabling is hard or costly. 
Uniview offers cameras with build-in wireless technology. And network cameras with build–in Wi-Fi 
module can easily be integrated into the network via wireless router. This part describes how to 
connect wireless network camera to the wireless network through Wi-Fi. 

 NOTE! 

 This section is applicable for cameras that support wireless connection. 

 Network cameras that support Wi-Fi connection do not support PoE (Power over Ethernet). 

 

Before you start, you need to establish a reliable wireless network via wireless router. And then do 
the following step to connect the network camera. 



2-4 

Steps: 

1. Set the IP address and subnet mask to the same segment as that of the wireless network. Please 
refer to Configuring the IP Address for detailed information. 

 

 NOTE! 

 If the camera’s IP address is in the same network segment of the wireless network, this step can be 
omitted. 

 To manipulate this step, you must cable the network camera to your computer. 

 The camera will reboot after the IP address is changed, please try the new IP address. 

 

2. Access the network camera by a web browser. You can turn to the section of Access from Web 
Browser for detailed information. 

3. Connect the camera to the network via the Wi-Fi function. 

4. Select the Setup tab on the upper menu bar of the interface (show as Figure 4-1) to enter the 
setting page. 

5. Enter Basic > Wi-Fi. 

6. Tick Enable to enable Wi-Fi function. Wireless networks will be automatically detected and then 
listed. 

7. Select the wireless network from the list, and click To connect.  

8. Input the password for the selected network.  
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3  Accessing the Network Camera 

Access from Web Browser 

Steps: 

1. Open the web browser. 

2. In the browser address field, input the IP address of the network camera, e.g., 192.168.0.13 and 
press the Enter key to enter the login interface. 

3. Install the plug-in before viewing the live video and managing the camera. Please follow the 
installation prompts to install the plug-in. 

a. Download the plug-in. Click Run Add-on on the pop menu to link File Download prompt 
box. 

 
 

b. Click Run to run the plug-in file now or click Save to save it. Running the file now is 
recommended. 

 
 

c. Click Run to start the installation procedure. 
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d. Click Next to continue. 

 
 

e. Click Browse to locate the installation folder, and then click Next. 

 
 

f. Click Install to start the installation.  

 
g. Click Finish to complete the installation process. 
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 NOTE! 

 You may need to close your web browser to complete the installation.  

 The tip box of the plug-in installation will be popped out when first-time login or the camera 
software version is updated. 

 The default IP address is “192.168.0.13”. 

 

4. Reopen the web browser after the installation is completed. 

5. Input your username and password. 

 
 

6. Click Login. 

 

 NOTE! 

 Both the default username and password is “admin”. 

 Tick  to display live video directly after login. 
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Access from EZManager Software 

EZManager is a client software of Uniview software suite, which provides multi-functionalities such 
as live view, parameter setting to manage network cameras. This section describes how to access 
live view and controlling interface of the network camera via EZManager.  

Accessing Live View 

Steps: 

1. Enter the EZManager software login interface. 

2. Input the username and password. 

 

 NOTE! 

Both the default username and password are “admin”. 

 

Figure 3-1 EZManager Login Interface 

 
3. Detect the network camera. For detailed information, please refer to Detecting Devices Online 

in the Appendix. 

4. Add the network camera (shown as Figure 3-2) as follows: select the camera by its name, IP 
address, type or serial number labeled on the product, click Add, and then click Close to close 
the Device Search box. The camera is listed on the Device managed list (shown as Figure 3-2).  

Figure 3-2 Select the Network Camera (1) 

 

1

2 3
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Figure 3-3 Select the Network Camera (2) 

 
 

5. Access the network camera for live view.  

a. Enter Live View interface. You can try either of the following two methods.  

b. Choose View > Live View. 

 
 

c. Click  to enter home interface, and then click Live View. 

 
 

d. Double-click the camera in the camera list. The live video is displayed on the 
quarter-split-screen display window. In addition, double-click the real-time video to obtain 
full-screen display. 

1

2

1

2
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Accessing Controlling Interface 

Steps: 

1. Enter the EZManager software login interface. 

 NOTE! 

Step 1-4 in this part differ little from step 1-4 of accessing live view. Please refer to Accessing Live 
View for detailed information. 

 

2. Input the username and password.  

3. Detect the network camera you want to access. 

4. Add the network camera. 

5. Access the controlling interface of the network camera as follows: right-click the camera in the 
device list, and then choose Remote Configuration from the pop-up menu to enter the 
controlling interface. 

 
 



3-7 



4-1 

4  Live View Configuration  

The following picture shows the live view page after you log in to the network camera through web 
browser. This page enables you to view live video, capture images, record video, control the PTZ, 
set/call presets and configure video parameters.  

Figure 4-1 Live View Page 

 

General Instructions of Live View Page 

Menu Bar: 

Icon Descriptions 

 

Enter the Home interface of the network camera, including live video and part of 
controlling setting.(Basically as Figure 4-1) 

 

Enter the Setup interface, which consists of four items setting, that is Basic, 
Service, Events and Maintenance setting. Please refer to Network Camera 
Configuration for more information. 

 
Get Help information. 

 
Quit the network camera from the web browser. 

 

Control Panel: 

Some Parameter Setting described below may not be displayed on the Live View page. The following 
provides an overview of each available item and function. 

Menu Bar

Control Panel

Live View
 Window

Tool Bar
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Parameter 

Setting 
Icon Descriptions 

Stream / 

Select the stream type for the live video in the live view 
window. 

Note: If you want to choose other stream to be played in the 
live view window, make sure corresponding video stream is 
enabled. Refer to Video Stream  for more information.  

Preset 
 Call the preset 

/  Add/delete a preset 

Speed 
 

Adjust speed of pan/tilt movements 

PTZ Control 

 

Click the direction buttons to control the pan/tilt 
movements. 

Note: To realize PTZ control, the camera must support PTZ 
function or an external pan/tilt unit has been installed. 

Focus  Focus near/far 

Zoom  Zoom in/out 

IR  Infrared light on/off 

Heat  Heater on/off 

Wiper  Wiper on/off 

Snow  Snow shaking on/off  

Light  Light on/off  

Image 
 

Enter image setting page of the device 

 

Live View Window: 

Display the live video. Meanwhile, in the live view window, you can use the right-click menu to adjust 
live view settings. The following describes some of the menu items. 

Parameter  
Setting 

Descriptions 

Aspect Ratio 

Set the video display ratio in the window 

Scale: in 16:9 mode 

Stretch: by the display window size 

Original: by the actual video size 

Video Effects 

Set some parameters for the video played in the window to improve the image 
quality.  

For more information, refer to Video Effects . 

System 
Configuration 

Set the local parameters of the client computer for related functions. 

For more information, refer to System Configuration . 
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Toolbar: 

Operations on the live view page, e.g., live view, capture, record, voice intercom, audio on/off, and 
etc. 

Icon Descriptions 

/  Start/stop live view. 

 
Capture snapshots from the screen. 

Note: The path for saving the snapshots can be specified in the System Configuration .  

/  
Start/stop local recording. 

Note: The path for saving the recordings can be specified in the  System Configuration . 

 Start voice intercom with the device. 

 Full screen display. 

 Adjust the output volume of the playing ActiveX for the client computer. 

 
Adjust the MIC volume at the computer side when voice intercom is conducted between 
the device and the computer. 

 

Video Stream  

Triple streams, that is, the primary stream, secondary stream and third stream, are provided to meet 
different bandwidth and frame rate requirements. You can choose one of them to be displayed in 
the live view window. 

 NOTE! 

Only Primary Stream is listed in the Stream option list unless other stream type is enabled. 

 

To enable the secondary stream or the third stream in the live view window, perform the following 
steps: 

1. Click the Setup tab on the upper menu bar of the interface (shown as Figure 5-1). 

2. Click Service > Encode. 

3. Select Enable Secondary Stream or Enable Third Stream as required, and then click OK to save 
the settings. 

 

 NOTE! 

 To enable the third stream, you must enable the secondary stream too.  

 To set video stream parameters, you can turn to Encoding for relevant information. 

 

4. Choose stream type to be played in the Stream option list on the control panel (shown as Figure 
4-1). 

 

Video Effects  

You can set parameters to improve the image quality of live videos displayed in the live video 
window. To configure video effects, you need do the following steps. 
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1. Click the Home tab on the upper menu bar of the interface (show as Figure 4-1). 

2. Right-click in the live view window, select Video Effects, and configure the following 
parameters. 

Configuration 
items 

Descriptions 

 Image Adjust 
Set brightness, contrast, Gamma, hue, and saturation values for decoded images 
to improve image quality. 

 Dynamic Contrast 
Enhance 

To enhance the image scene depth, you can select the Bright mode or Soft mode 
and set the proper intensity. 

Static Clear Adjust static images to improve image quality. 

Sharpness Sharpen the images to improve image quality. 

Image stabilizer Reduce the image noise to improve image quality at night. 

 

System Configuration  

This section describes how to set the local parameters for your client computer. Please follow the 
steps below to perform system configuration. 

1. Click the Home tab on the upper menu bar of the interface (show as Figure 4-1). 

2. Right-click in the live view window, select System Configuration, configure the parameters 
listed in the following table, and then click OK to save the settings. 

Panel  

Name 

Configuration 
Items 

Descriptions 

Video Param 

Display Mode 

Includes High Quality and Common.  

Note: If the client computer supports Direct 3D, it is 
recommended to select High Quality for better image effect. 

Video Pixel Format 

Video data format at the client computer. 

Note: RGB32 is suitable for old display cards. YUV420 is 
recommended if the client computer supports YUV420.  

Audio Encoding 
Format 

Audio encoding format at the client computer. 

Processing Mode 
When the network is under good conditions, Real Time Prior is 
recommended; otherwise, select Fluent Prior.  

Transmission 

Stream transport protocol at the client computer. 

Note:  If the current stream transport protocol is changed, the 
live view is automatically interrupted; and a new live view is 
established using the new protocol.  

Audio Code 
Sampling Rate(Hz) 

Audio sampling rate at the client computer. 

Record and  
Snapshot 

Recording Do recording according to size or time of the recording file. 

Subsection  The maximum size/time duration for a single recording file. 
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Panel  

Name 

Configuration 
Items 

Descriptions 

Size /Time 

Record Overwrite 

The policy to be taken when recording file overflows. 

Note: Overwrite means that new recording overwrites the 
current recording. Full Stop means that the recording stops so 
that the current recording can be kept. 

Local Recording 
Format 

Format of local recordings.  

Local Recording 

Path on the client computer for saving recordings.  

Note: You can click the button  on the right to locate the 
folder.  

Snapshot Folder 

Path on the client computer for saving the snapshots. 

Note: You can click the button  on the right to locate the 
folder.  

Total Capacity Total capacity allocated for local recordings. 

Snapshot Format Snapshot image format. 
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5  Network Camera Configuration 

Basic 

Network 

This section describes how to configure network parameters for the device, such as IP address, so 
that the device can be integrated to the network. 

 

 NOTE! 

Network settings must be properly configured before you operate the camera over network. 

 

Steps: 

1. Enter the Network interface: 

Setup > Basic > Network 

 
 

2. Configure the parameters as listed in the following table. 

Configuration items Description 

IP Obtain Mode 

 Static Address (Manual): Configure the IP address, subnet mask and default 
gateway for the camera, making sure that the IP address is unique in the 
system.  

 PPPoE: Enter the username and password that the ISP (Internet Service 
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Configuration items Description 

Provider) provides.  

 DHCP: The IP address is obtained automatically. This feature is enabled by 
default. 

MTU 
Maximum Transmission Unit (MTU) is used for fragment and reassembly of IP 
packets. Its default value is 1500 bytes within the range 500 ~ 1500. 

UNP 

UNP Service 
If this service is enabled, the IP address is assigned by the Universal Network 
Passport (UNP) server. 

Server 
Address 

IP address of the UNP server. 

Authentication 
If authentication has been enabled on the UNP server, authentication must be 
enabled here on the device, and the username and password are required for 
authentication. 

Username 
UNP username, which must be consistent with that configured on the UNP 
server. 

Password 
UNP password, which must be consistent with that configured on the UNP 
server. 

Port Type Type of the port for communication. 

Operating Mode NIC speed and duplex mode. 

 

3. Click OK to save the settings. 

 

 NOTE! 

The device will reboot after its IP address is changed. 

 

Image 

This section describes how to set live view image parameters to meet image quality requirements in 
different scenes. The default scene remains unchanged until the switching conditions for a specific 
scene are met. 

 

 NOTE! 

The Image parameters vary depending on the model of the camera. For more information, please 
refer to the web interface. 

 

Setting Default Scene 

1. Enter the Image interface: 

Setup > Basic > Image 
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2. Select the Default Scene radio button to set the image parameters. The following table lists all 
parameters. 

Configuration items Description 

Image 
Enhance 

Brightness 
The image brightness default value is 128, where a higher 
value produces a brighter image. 

Contrast The default value is 128. 

Saturation 
The saturation default value is 128. Lower values mean less 
color saturation. 

Hue The default value is 128. 

Sharpness The default value is 128. 

Image Rotation 

 Normal: No rotation processing for the images. 

 Flip Vertical: Rotation processing for the images in the 
vertical direction. 

 Flip Horizontal: Rotation processing for the images in the 
horizontal direction. 

 180°: Rotate the images 180 degrees. 

 90° CW: Rotate the images 90 degrees clockwise for 
corridor mode. 

2D Noise Reduction 
 The default value is 128. Noise reduction might result in 

blurred image details.  

3D Noise Reduction  3D noise reduction might result in image smear. 

Exposure 
Parameters 

Exposure Mode Different modes result in different exposure effects. 

Shutter 

Fast shutter speed is suitable for scenes in motion, and slow 
shutter speed is suitable for scenes with few changes.  

Note: 

 When the exposure mode is manual exposure or shutter 
priority, the time value can be set. When the exposure 



5-4 

Configuration items Description 

mode is custom exposure, the minimal and maximum time 
values can be set. 

 When you set the shutter speed, the reciprocal of the 
shutter speed must not be less than the frame rate if slow 
shutter is not enabled. Otherwise, image quality might be 
adversely affected. 

Gain 

Control the level of amplification to provide a better image in 
low light situations.  

Note: A high gain will also increase the amount of noise. 

The gain value is allowed to be set in manual or gain priority 
exposure mode. And its minimal and maximum can be set in 
custom exposure mode. 

Slow Shutter 
Slow shutter decreases the shutter speed in low light to 
improve image brightness. 

Slowest Shutter This item can be adjusted after Slow Shutter is enabled. 

Compensation 

Adjust exposure compensation value to get the desired image 
quality. 

Note: This item is configurable when the exposure mode is not 
manual. 

Metering Control 

Select metering mode of the device. 

 Center Weighted: The meter concentrates the central part 
more than the rest area.  

 Evaluative Metering: Measures user-customized area. 

Note: This item is configurable when the exposure mode is not 
manual. 

Day/Night Mode 

 Automatic: The device outputs the best images according 
to the illumination environment and switches between the 
black/white mode and color mode.  

 Night: The device provides the best black/white images 
according to the illumination environment. 

 Day: The device provides the best colorful images 
according to the illumination environment.  

Day/Night Sensitivity 

Response time for switching the black/white mode and color 
mode when the ambient light changes. A smaller value means 
a higher switching speed.  

Note: This item is configurable when the Day/Night mode is 
Automatic.  

Day/Night 
Switching(s) 

Duration time to switch between the black/white mode and 
color mode when the ambient light changes.  

Note: This item is configurable when the Day/Night mode is 
Automatic. 

WDR 

Enabling WDR makes both the light and dark areas clearer.  

Note: This item is configurable when the exposure mode is not 
manual or custom. 
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Configuration items Description 

WDR Level 
This item can be adjusted for better image quality after WDR is 
enabled. 

Intelligent IR 

IR Control Mode 

 Global Balance: Adjust IR light brightness and exposure 
parameters to achieve balanced image effect 
automatically. Note that some areas might be over 
exposed if you select this option. This mode is 
recommended if monitored range and image brightness 
are your concerns. 

 Over-Exposure Suppression: Adjust the IR light brightness 
and exposure parameters to prevent partial over-exposure 
automatically. Note that some areas might be dark if you 
select this option. This mode is recommended if clear and 
proper exposure in the monitored area is your concern. 

 IR Manual: Manually controls the IR light brightness. 

Infrared Level 

Set the IR light level. A larger value yields stronger IR light. A 
value of 0 turns the IR light off. 

Note: This item can be adjusted when the IR Control Mode is 
Over Exposure Restrict. 

White Balance 

White Balance 

White balance ensures image colors always appear normal and 
correct the error caused by the light source. 

Auto: The device automatically controls the red gain and blue 
gain according to the light source. 

Fine Tune: You can manually adjust the red and blue offsets. 

Indoor: This mode is recommended for indoor scenes. 

Outdoor: This mode is recommended for outdoor scenes. 

Red Offset 

Adjust the red gain for the white balance mode. 

Note: This item is configurable when the white balance mode 
is Fine Tune.  

Blue Offset 

Adjust the blue gain for the white balance mode. 

Note: This item is configurable when the white balance mode 
is Fine Tune.  

Advanced Defog 
This item makes images clearer in fog or mist situation. 

Note: The higher level means greater defog effect. 
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 NOTE! 

 You can use the slide bar to adjust the image parameter, or directly enter the value in the text box after 

the slide bar.  

 If the reciprocal of the shutter speed is less than the frame rate (for example, the frame rate is 30, and 
the shutter speed is 1/15), the images might flash. You should make sure the reciprocal of the shutter 
speed is not less than the frame rate. 

 To restore all image parameters to their defaults, click Default. 

 On the preview pane, you can use the right-click menu to perform live view. The following 
describes the menu options: 

Full Screen/Normal View is used to play live view in full screen mode or exit the full screen mode. 
Aspect Ratio is used to set the image display ratio on the pane. For example, if you want HD 
images to be played in 16:9 mode, you can select Aspect Ratio > Scale. If you want to display 
images by the pane size, you can select Aspect Ratio > Stretch. 

 

Setting Non-default Scene 

1. Enter the Scenes interface: 

Setup > Basic > Image 

 
 

2. Select the radio button for a non-default scene, configure the parameters as listed in the 
following table. 

Configuration 
items 

Description 

Current 

Displays the current scene in use. 

Note: You can select the radio button for a scene to switch to the scene. The image 
parameters are also adjusted to suit the scene. 

Scene Name Name of the current scene. 

Auto Switching 

Adds the scene to the auto-switching list.  

Note: After this option is selected, the system can automatically switch to the 
specific scene when the switching criteria are met. The auto switching list already 
contains the default scene. 

Setup 

Click  to configure the auto switching criteria, including the valid time range (start 
time and end time) for auto switching and illumination range. The time ranges 
cannot overlap each other. 

Auto switching occurs only when the illumination range is covered in the valid time 
range. A value of 0 means the criteria are not effective. 

 

3.  For more information about how to configure the image parameters for a specific scene, refer 
to Setting Default Scene. 
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4. Repeat the previous steps to configure other non-default scenes. 

5. Select Auto Switching. The device can automatically switch to the specific scene when the 
switching criteria are met.  

 

 NOTE! 

 If you have selected Auto Switching, you cannot configure scene parameters. The device 
automatically switches scenes according to the existing configuration.  

 If multiple non-default scenes meet the switching criteria, the device switches the scene to the one 
with the smallest ID. The scene IDs are 1, 2, 3, and 4. 

 

System 

You can change the system time, device ID, and server IP Address. 

When the device is managed in a centralized way, its SD card can be used as a backup of the central 
server storage. If the communication between the network camera and central storage is interrupted 
due to network problems, the front-end network camera temporarily stores the video data in the SD 
card. In this case, it is recommended to enable recording backup. Normally, the system backs up 
recordings on the SD card of a front-end network camera to the backup server if the SD card contains 
recordings and the network camera and the backup server can communicate.  

To back up recordings, make sure there is an SD card in the network camera, and configure backup 
resources on the central server for the network camera, and configure the recording backup 
parameters on the web interface of the network camera.  

 

 
CAUTION! 

Changing the device ID or VM server IP address will cause the device to reboot. In this case, the 
login password and system time will be synchronized with the new central server, and all the other 
parameters will be restored to the factory defaults except the NIC parameters, VM server 
parameters, image parameters, OSD parameters, custom user information and ROI parameters. 

 

Steps: 

1. Enter the System interface: 

Setup > Basic > System 

 
 

2. Configure the parameters as listed in the following table. 
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Configuration 
items 

Description 

System Time Set the system time.  

NTP If NTP is enabled, system time is synchronized with the NTP server periodically. 

Server Address Make sure this Address is consistent with that of the IP address of NTP Server. 

Device ID 
When the device is managed by the central server, make sure the device ID is 
unique. 

Protocol 

Make sure this protocol is consistent with that of the central server management 
protocol. 

Note: Choose “None” when device is standalone. 

Server IP 

Make sure this IP address is consistent with that of the central server. 

Note: This item needs to be configured when the device is managed by the 
central server. 

Server Port 

Port number used for communicating with the central server, which must be 
consistent with the SIP port number of the central server. The default value is 
5060. 

Note: This item needs to be configured when the device is managed by the 
central server. 

Recording Backup 

Enable or disable recording backup. 

Note: This item needs to be configured when the device is managed by the 
central server. 

BM IP 
Make sure this IP address is consistent with that of the backup server. 

Note: This item is configurable only when recording back is enabled. 

 

3. Click OK to save the above settings. 

Service 

In this section, you can configure the encoding settings, Audio settings, OSD settings, ROI settings, 
Media stream settings and Preset patrol configuration.  

Encoding 

This section describes how to set the video standard and encoding parameters for different streams, 
and how to display the current status of the BNC output. 

 

 NOTE! 

 The parameters for the secondary stream and third stream are similar with those of the primary 
stream. Unless otherwise specified, the following table takes the primary stream as an example.  

 Some device models support third stream. To enable it, make sure Secondary Stream must be 
enabled simultaneously. 

 

Steps: 

1. Enter the Encode interface: 



5-9 

Setup > Service> Encode 

 
 

2. Configure the parameters as listed in the following table: 

Configuration items Description 

Capture Mode Specify a video standard. 

Encoding Format Video encoding format. 

Encoding mode 

 CBR: The device uses constant encoding bitrate to send data. 

 VBR: The device dynamically adjusts the encoding bitrate according to the 
image quality. 

Frame Rate 

Image encoding frame rate. The unit is frame per second (FPS). 

Note: To ensure image quality, the frame rate cannot be larger than the 
reciprocal of the shutter speed if you have set the shutter speed. 

Resolution Resolution of the encoded images. 

Bitrate When the encoding mode is VBR or CBR, this value is the maximum bitrate.  

Image Quality 

When the encoding mode is VBR, you can set the quality level for encoded 
images. A value closer to bitrate priority means a smaller bitrate but might 
result in poor image quality. A value closer to quality priority means a larger 
bitrate and higher image quality. 

I Frame Interval It is recommended that this value be consistent with the frame rate. 

GOP GOP (Group of pictures) structural parameter.  

Smoothing 

Stream smoothening level. Clear means stream smoothen is not enabled. A 
value closer to Smooth means a higher smoothening level but might adversely 
affect image clearness.  

Note: In poor network environment, enabling stream smoothing makes 
images smoother. 
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Audio 

This section describes how to set audio encoding parameters.  

 

 NOTE! 

Some device models don’t support audio settings. For more information, refer to the web interface. 

 

Steps: 

1. Enter the Audio interface: 

Setup > Service > Audio 

 
 

2. Configure the parameters as listed in the following table: 

Configuration 
items 

Description 

Audio Input 

Enables/disables audio input. If you disable audio input, no audio data is encoded. 

Note: You can disable audio input if audio is not required. In this case, the device 
performance can be improved to some extent. 

Input Gain Amplifying value for audio sampling. A larger value yields a higher amplifying ratio.  

Encoding Format Audio encoding format. 

Sampling Rate Audio sampling rate. 

 

3. Click OK to save the above settings. 

OSD 

On-screen display (OSD) displays characters overlaying on the video images. OSD contents include 
time and other custom contents. 

In some scenarios, it is required to hide some sensitive or privacy related areas on the live view, for 
example, the keyboard at the ATM. The feature for this requirement is called privacy mask. The 
privacy mask always works to hide the specified area regardless of the operations you perform.  
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 NOTE! 

On the preview pane, you can use the right-click menu to establish full-screen live view. The 
following describes the menu options: 

Full Screen/Normal View is used to play live view in full screen mode or exit the full screen mode. 

Aspect Ratio is used to set the image display ratio on the pane. For example, if you want HD images 

to be played in 16:9 mode, you can select Aspect Ratio > Scale. If you want to display images by the 

pane size, you can select Aspect Ratio > Stretch.  

 

Steps: 

1. Enter the OSD interface 

Setup > Service > OSD 

 
 

2. Configure the following settings. In the overlay OSD area, set the OSD position, OSD content, 
overlay area, and content style. After you specify the OSD position and set the content, on 
the status bar means that the OSD settings are valid. At an OSD position, you can enter multiple 
lines as the content, and use the buttons  and  to adjust their display sequence. 

3. In the privacy mask area, click the  button to add a new mask and click the  button to delete 
a mask. 

 

Region of Interest (ROI)  

If ROI is chosen, image quality in this region is first guaranteed when bandwidth is not enough. This 
section describes how to set audio encoding parameters.  

 

 NOTE! 

Some device models don’t support ROI. For more information, refer to the web interface. 

 

Steps: 

1. Enter the Region of Interest Settings interface. 

Setup > Service > Region of Interest 
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2. If “Enable Region of Interest” is chosen, you can draw the region of interest on the image. 

 

 NOTE! 

On the preview pane, you can use the right-click menu to establish full-screen live view. The 
following describes the menu options: 

Full Screen/Normal View is used to play live view in full screen mode or exit the full screen mode. 
Aspect Ratio is used to set the image display ratio on the pane. For example, if you want HD images 
to be played in 16:9 mode, you can select Aspect Ratio > Scale. If you want to display images by the 
pane size, you can select Aspect Ratio > Stretch. 

 

Media Stream 

This section describes how to set the unicast or multicast IP address and port number for decoder 
that receives audio/video streams, and display media stream transport protocol. 

Steps: 

1. Enter the Media Stream interface: 

Setup > Service > Media Stream 

 
 

2. Click the  button to specify the unicast or multicast IP address and port number for the 
decoder end that outputs streams and receives audio/video streams.  
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You can delete a stream by clicking the  button 

3. Click Submit to complete the configuration. 

 

 NOTE! 

 Choose “Persistent” if you need to establish the configured media stream automatically when 
the device reboots. .  

 Only Primary Stream is listed in the Stream Profile list unless other stream type is enabled. 

 

Preset Patrol 

Preset patrol means that the PTZ camera rotate among multiple preset positions, or rotate following 
a specified route, for example, turn upward or turn left. You can rotate the PTZ camera and set the 
preset positions according to the current live view preview, and perform some operations to the PTZ 
camera.  

 

 NOTE! 

Some device models don’t have Preset Patrol Settings. For more information, refer to the web 
interface. 

 

To configure preset patrol, please follow the steps below. 

1. Enter the Preset Patrol interface: 

Setup > Service > Preset Patrol 
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2. In the Patrol Route drop-down box, set preset positions or perform some operations to the PTZ 
camera. For more information, refer to Live View Configuration .  

 To add the current PTZ position as a preset position, click Add to the right of the drop-down box, 
enter the route ID and name, and click OK.  

 To have the PTZ moving to a preset position, select the corresponding preset item from the 
Patrol Route drop-down box and click Patrol.  

 To delete a preset position, select the preset item from the Patrol Route drop-down box and 
click Delete.  

 

To add a patrol route, please follow the steps below. 

1. Enter the Preset Patrol interface: 

Setup > Service > Preset Patrol 

2. Click Add near the Patrol Route drop-down box. 

3. In the Patrol Route Content area, enter the route name and ID, and click Add to add patrol 
actions. You can adjust the action sequence in the patrol route by clicking the corresponding 
buttons. Patrol actions include the following: 

 After you click Add, you can configure the PTZ camera to rotate to the preset position and the 
hold time. 

 After you click Add, you can specify the rotation direction, zoom value, rotation speed, rotation 
duration, and hold time, or you can configure the PTZ camera to keep rotating. 

 

 NOTE! 

It is recommended that the first action in the patrol route is rotating to the preset position. 

 

4. Click OK to confirm the configuration. 

 

To start a patrol route, please follow the steps below. 

1. Enter the Preset Patrol interface: 

Setup > Service > Preset Patrol 

2. From the Patrol Route drop-down box, select the patrol route to be started, and click Patrol. 
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To delete a patrol route, please follow the steps below. 

1. Enter the Preset Patrol interface: 

Setup > Service > Preset Patrol 

2. From the Patrol Route drop-down box, select the patrol route to be deleted, and click Delete. 

 

Storage 

 NOTE! 

To configure record settings, please make sure that you have the network storage device within 
the network or the SD card inserted in your camera 

 

Storage Settings contain the edge storage and endpoint cache. The endpoint storage sends data to 
Micro SD. This mode is suitable for the device standalone operation. The endpoint cache makes the 
Micro SD as backup of the Center Server, which means, data is stored to Micro SD when the Center 
Server Storage fails, and update to the Backup Server for Cache Post Recording (For more 
information, refer to System Configuration ).  

Steps: 

1. Enter the Storage interface: 

Setup > Service > Storage 

 
 

2. Configure the parameters as listed in the following table: 

Configuration 
items 

Description 

Storage 
Medium 

Type of the storage medium. 

 Click Format and click OK to format the storage medium (Micro SD). It will ask for a 
reboot to format the storage medium. 

 Total Capacity and Idle Capacity of the Micro SD are shown on the web. 

Endpoint 
Storage 

Specify Enable or Off the Endpoint Storage. 

Note:The Endpoint Cache is enabled when the Endpoint Storage is off and the Centre 
Server Storage is failed. 

Stream Specify the stream to be stored. 

Data 
Overwrite 
Policy 

Overwrite: Data is overwritten from the beginning when the storage capacity is full. 

Stop: Data is not written when the storage capacity is full. 
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3.  Click OK to confirm the configuration. 

 

 NOTE! 

 The endpoint storage and endpoint cache cannot be configured at the same time because only one 
Micro SD is supported as storage media.  

 It is suggested to enable the endpoint storage when the service is in the standalone status, and 
disable this function when the device is centralized managed, otherwise, it may influence the 
Endpoint Cache. 

 

Events 

You can use event settings to implement alarm reporting and associate actions to specific alarms, so 
that the system can take proper actions in time in response to the alarms. Event configuration covers 
Motion Detection, Occlusion Detection, Temperature Alarm, Boolean input/output alarms and Audio 
Alarm. 

 

 NOTE! 

Some device models have different associate actions. For more information, refer to the web 
interface. 

 

Motion Detection 

Motion detection is a feature which can take alarm response actions and record the video for the 
motion occurs in the surveillance scene. 

 

 NOTE! 

Some device models don’t have PTZ Control, and some have different associate actions. For more 
information, refer to the web interface. 

 

Steps: 

1. Enter the Motion Detection interface 

Setup > Events > Motion Detection 



5-17 

 
 

2. In the Detection Area part, click the  button to add an area. 

3. Drag the rectangle frame of the area to set its position and range. 

4. Set the Sensitivity, Object size, and History for motion detection as the alarm report criteria. 

 

 NOTE! 

 A larger sensitivity value means a higher detection level (a little change in the area can be 

detected). When the change scope exceeds the object size and the change duration exceeds 

the specified duration, the alarm is reported. 

 The motion detection results are displayed in real time on the page, and the red ones are the 
reported ones. 

 

5. Configure the parameters as listed in the following table: 

Configuration 
items 

Description 

Output Boolean 1 

Specifies the alarm output port associated with the motion detection alarms. 

Note: When an alarm occurs, the device triggers corresponding Boolean alarm, 
thus triggering the action on the third-party device. 

PTZ to Preset 

Specifies the PTZ preset position associated with the motion detection alarms. 

Note: 

 This item is configurable only after you add preset positions on the preset patrol 
setting page.  

 When an alarm occurs, the alarm triggers the PTZ camera to rotate to the 
preset position automatically, so that users can capture the images at site. 

Enable Plan 

Select this checkbox and specify the time segment for the arming plan (including 
the start time and end time). The time segments you specify cannot overlap each 
other. The device outputs alarm signals only in the valid time segments. 

Week days include Monday to Sunday, and each day is divided into four time 
segments. 

Note: After you complete setting the time segments for a day, you can Copy and 
Paste the time segments to another day.  
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6. Click OK to complete the configuration. 

 

Occlusion Detection 

Steps: 

1. Enter the Occlusion Detection interface: 

Setup > Events > Occlusion Detection 

 
 

2. Set the Occlusion Detection, Sensitivity and Duration parameters. Occlusion is easier to be 
detected with a higher value of Sensitivity (for example, A further/smaller occlusion may be 
detected in a high sensitivity). Alarm occurs when the lens is occluded and lasts for more than 
the time of duration. 

3. Configure the parameters as listed in the following table: 

Configuration 
items 

Description 

Output Boolean 1 

Specifies the alarm output port associated with the occlusion detection alarms. 

Note: When an alarm occurs, the device triggers corresponding Boolean alarm, 
thus triggering the action on the third-party device. 

PTZ to Preset 

Specifies the PTZ preset position associated with the motion detection alarms. 

Note: 

 This item is configurable only after you add preset positions on the preset 
patrol setting page.  

 When an alarm occurs, the alarm triggers the PTZ camera to rotate to the 
preset position automatically, so that users can capture the images at site. 

Enable Plan 

Select this checkbox and specify the time segment for the arming plan (including 
the start time and end time). The time segments you specify cannot overlap 
each other. The device outputs alarm signals only in the valid time segments. 

Week days include Monday to Sunday, and each day is divided into four time 
segments. 

Note: After you complete setting the time segments for a day, you can Copy and 
Paste the time segments to another day.  
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4. Click OK to complete the configuration. 
 

Temperature Alarm 

 NOTE! 

Some device models don’t support Temperature Alarm Settings, and some have different associate 
actions. For more information, refer to the web interface. 

 

Steps: 

1. Enter the Temperature Alarm interface: 

Setup > Events > Temperature Alarm. 

 
 

2. Configure the parameters as listed in the following table. 

Configuration items Description 

High/Low Temperature 
Threshold (Lower/Upper Limit) 

Upper/lower limit for triggering temperature alarms. 

Output Boolean 1 

Specifies the alarm output port associated with the temperature 
alarms. 

Note: When an alarm occurs, the device triggers corresponding 
Boolean alarm, thus triggering the action on the third-party device. 

PTZ to Preset 

Specifies the PTZ preset position associated with the temperature 
alarms. 

Note: 

 This item is configurable only after you add preset positions on the 
preset patrol setting page.  

 When an alarm occurs, the alarm triggers the PTZ camera to 
rotate to the preset position automatically, so that users can 
capture the images at site. 

3. Click OK to complete the configuration. 
 

Input Alarm 

 NOTE! 

Some device models don’t support Input Alarm Settings. For more information, refer to the web 
interface. 
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Steps: 

1. Enter the Input Alarm interface: 

Setup > Events > Input Alarm 

 
 

2. Configure the parameters as listed in the following table. 

Configuration items Description 

Boolean Selection Input port for external alarms.  

Boolean Name N/A 

Status 

Specifies the Boolean input as On or Off according to the status of the 
third-party alarm input device. For example, if the alarm input device is Normal 
On, you must set this value to On for the device to receive the alarms from the 
third-party devices properly.  

Boolean Enabled Enables/disables Boolean. 

Enable Plan 

Specifies the start time and end time for arming. The time segments cannot 
overlap each other. The device outputs alarm signals only in the valid time 
segments. Week days include Monday to Sunday, and each day is divided into 
four time segments. 

Note: 

 After you complete setting the time segments for a day, you can Copy and 
Paste the time segments to another day.  

 This item is configurable only after Boolean is enabled. 

Output Boolean 1 

Specifies the alarm output port associated with the Boolean input alarms. 

Note: When an alarm occurs, the device triggers corresponding Boolean 
alarm, thus triggering the action on the third-party device. 

PTZ to Preset 

Specifies the PTZ preset position associated with the Boolean input alarms. 

Note: 

 This item is configurable only after you add preset positions on the preset 
patrol setting page.  

 When an alarm occurs, the alarm triggers the PTZ camera to rotate to the 
preset position automatically, so that users can capture the images at site. 
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3. Click OK to complete the configuration. 

 

Output Control 

 NOTE! 

Some device models don’t support Output Control Settings. For more information, refer to the web 
interface. 

 

Steps: 

1. Enter the Output Control interface: 

Setup > Events > Output Control 

 
 

2.  Configure the parameters as listed in the following table. 

Configuration items Description 

Boolean Selection 
Specifies the alarm output port associated with motion detection alarms, 
temperature alarms or Boolean input alarms. 

Boolean Name N/A 

Status 

Specifies the Boolean output as On or Off according to the status of the 
third-party alarm output device. For example, if the alarm output device is 
Normal On, you must set this value to On for the device to output alarms to the 
third-party devices properly.  

Alarm Duration Duration for outputting alarms.  

 

 
CAUTION! 

When the device is connected to an alarm output device, please strictly follow the following 
power-on sequence. Otherwise, IPC internal components might be damaged. 

The power-on sequence is as follows: 

(1) Make sure the Boolean output is set to On (the default). Make sure the IPC and the alarm 
output device is powered off when you connect them.  

(2) After the connection, power on the alarm output device, and then power on the IPC.  

 

3. Click OK to complete the configuration. 
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Audio Alarm 

This section describes how to configure the audio alarm to the IPC audio input. The audio alarm is 
detected when change range of volume exceeds a certain value or its value exceeds a certain 
threshold with alarm reporting and associate actions. 

 

 NOTE! 

Some device models don’t support Audio Alarm Settings, and some have different associate 
actions. For more information, refer to the web interface. 

 

Steps: 

1. Enter the Audio Alarm interface: 

Setup > Events > Audio Alarm 

 
 

2. Configure the parameters as listed in the following table. 

Configuration items Description 

Audio Detection 
Make sure the device is connected to external audio input device if Audio 
Detection is Enabled. 

Detection Type 

 Rises Above: The alarm occurs when volume rising range exceeds certain 
value.  

 Falls below: The alarm occurs when volume falling range exceeds certain 
value.  

 Passes: The alarm occurs when volume rising or falling range exceeds 
certain value.  

 Threshold: The alarm occurs when volume exceeds threshold. 

Difference/Threshold 

 Threshold: Set the threshold for generating alarms 

 Difference: generates an alarm when the difference of two specific 
volumes exceeds this value. 

Note:  

 You can check volume using the meter on the left side of the page. 

 Threshold is shown when the Detection Type is “Threshold”, otherwise 
Difference is shown. 

 The audio detection results are displayed in real time on the page, and the 
red ones are the reported ones.  
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Configuration items Description 

 

Output Boolean 1 

Specifies the alarm output port associated with the audio detection alarms. 

Note: When an alarm occurs, the device triggers corresponding Boolean alarm, 
thus triggering the action on the third-party device. 

PTZ to Preset 

Specifies the PTZ preset position associated with the audio detection alarms. 

Note: 

 This item is configurable only after you add preset positions on the preset 
patrol setting page.  

 When an alarm occurs, the alarm triggers the PTZ camera to rotate to the 
preset position automatically, so that users can capture the images at site. 

Enable Plan 

Select this checkbox and specify the time segment for the arming plan 
(including the start time and end time). The time segments you specify cannot 
overlap each other. The device outputs alarm signals only in the valid time 
segments. 

Week days include Monday to Sunday, and each day is divided into four time 
segments. 

Note: After you complete setting the time segments for a day, you can Copy 
and Paste the time segments to another day.  

 

3. Click OK to complete the configuration. 
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6  Others 

Maintenance 

Device Status 

You can check the device status in real time, making the device easy to maintain. 

Steps: 

1. Enter the Device Status interface 

Setup > Maintenance > Device Status 

 
 

2. View the device status. 

Attributes Description 

IP Address Current IP address of the device. 

Subnet Mask Subnet mask for the current IP address of the device. 

Gateway 
Address 

Current gateway IP address of the device. 

Device Type Device model. 

Software 
Version 

Current software version of the device. 

Hardware 
Version 

Current hardware version of the device. 

BootROM 
Version 

Current BootROM version of the device. 

Device Serial 
No. 

Serial No. of the device, which is on the label attached to the device. 



6-2 

Attributes Description 

Server Status 
Status of the central server connected to the device when the device is managed 
by the central server. 

Server IP 
IP address of the central server in scenarios where the current device is under the 
management of the central server. 

Server Port 
Port number of the central server for communicating with the device when the 
device is managed by the central server. 

System Time Current system time of the device. 

Running Time Uninterruptedly running time of the device. 

Main Board 
Temperature 

Current temperature of the main board. 

 

User Management 

 NOTE! 

 The default administrator user account is “admin”, which cannot be renamed. The administrator 
has all management and operation permissions, and the other operators have only the live view 
permission.  

 After you change the username or password of a user account, you will be logged out if 

you have logged in using the user account. To log into the system using the user 

account again, you need to provide the new username or the password. 

 If you delete an operator, the operator is forcedly logged out. 

 

Steps: 

1. Enter the User Management interface 

Setup > Maintenance > User Management 

 
 

2. Select a user type. You can add an operator or modify the username and password for an 
operator. If you want to delete an operator, clear the username of the operator. 

3. Click OK to confirm the configuration. 
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Device Maintenance 

Software Upgrade 

When the devices are managed in a centralized way, it is recommended to upgrade the devices 
through the central server if you want to upgrade them in batches. For more information, refer to 
the online help for the central server. 

1. Enter the Device Maintenance interface 

Setup > Maintenance > Device Maintenance 

 
 

2. In the Software Upgrade area, click Browse and select the upgrade folder where the upgrade 
files reside.  

3. Click Upgrade and click OK to launch the software upgrade process. The device will reboot 
automatically after the upgrade process completes. 

 

 NOTE! 

The upgrade folder must contain all necessary upgrade files. 

 

System Restart 

 

 
CAUTION! 

System reboot might interrupt the services. Make sure you understand the impacts before you 
reboot the system. 

 

1. Enter the Device Maintenance interface 

Setup > Maintenance > Device Maintenance 

2. In the System Restart area, click Restart and click OK. 

 



6-4 

Config Management 

You can export the current device configuration file to the local computer or other storage medium 
for backup purposes, or import the previously exported configuration into the device to restore the 
configuration. 

 

 
CAUTION! 

 Make sure the configuration file to import is of a device that is of the same model. A wrong 
configuration file might cause device exception. 

 After the configuration file is imported successfully, the device will restart. 

 If you restore the default configuration, all parameters will be restored to the factory defaults 
except the network setting, system time. 

 

1. Enter the Device Maintenance interface 

Setup > Maintenance > Device Maintenance 

2. In the Config Management area, select the configuration file by clicking Browse… in the 
Importing row and then to import the local configuration file. The system will prompt the result 
after the import process completes. 

3. To export the current configuration, click Browse in the Exporting row, set the path for saving 
the configuration file, and click Export. 

4. To restore the default configuration, click Default and then click OK. The device will then restart 
with the default configuration. 

 

Diagnosis Information 

Diagnosis information includes log information and system configuration information. You can 
export diagnosis information as a local file.  

1. Enter the Device Maintenance interface 

Setup > Maintenance > Device Maintenance 

2. In the Diagnosis Info area, clicking Browse to select the path for saving the information and 
then click Download to save the diagnosis information as a file in the specified folder. 

 NOTE! 

The diagnosis information is saved in .tgz files. You can decompress the files and open them using a 
text editor. 

 

Serial Port 

The serial port settings must match the settings of the other device connected to the serial port. 
RS-485 serial ports are used to control PTZ cameras and to transparently transmit data with 
third-party devices.  

If the device supports PTZ control and you specify the serial port mode as PTZ control on the central 
server, you must also login to the device and select PTZ mode for the serial port setting through the 
web interface. 

 NOTE! 

Some device models do not support serial port settings. For more information, refer to the web 
interface. 

. 
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Steps: 

1. Enter the Serial Port interface: 

Setup > Basic> Serial Port 

 
 

2. Configure the parameters as listed in the following table. 

Configuration 
items 

Description 

Port Name of the serial port to be set. 

Port Type Type of the serial port to be set. 

Port Mode 

 PTZ Control: Uses the RS-485 serial port to control a PTZ camera. 

 Trans-Channel: Uses the RS-485 serial port to transparently transmit data with a 
third-party device. 

 OSD: Uses the RS-485 serial port to receive serial data with a third-party device 
and reparse it, then display in the overlay OSD. 

Note: 

If OSD is specified, make sure the format of serial data sent from the third-party device 
meets our data format. (For more information, contact our Support) 

Baud Rate 

The default value is 9600. 

Note: The baud rate of the serial port must be consistent with that of the device 
connected to the serial port. 

Data Bits The default value is 8.  

Stop Bits The default value is 1.  

Parity The default value is None.  

Flow Control The default value is None.  

PTZ Protocol 

Sets the PTZ protocol supported by the channel. 

Note: 

 This item is configurable only when the serial port mode is PTZ control. 

 If you select INTERNAL-PTZ as the PTZ protocol, the serial port is not used for 
external PTZ and its parameters are unavailable. You can perform control over 
internal PTZ after you connect the focus/zoom interface to the lens.  

PTZ Mode 
 Internal PTZ Priority: The device first uses internal PTZ functions (for example, 

focus and zoom) rather than external PTZ. If a PTZ function is not available on the 
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Configuration 
items 

Description 

device, the device then uses the external PTZ. 

 External PTZ Priority: The device uses the external PTZ to perform PTZ operations. 

Note: 

 This item is configurable only when the serial port mode is PTZ control. 

 If you select INTERNAL-PTZ as the PTZ protocol, the PTZ mode is fixed to Internal 
PTZ Priority. The serial port cannot be used for external PTZ.  

 Before using PTZ control, make sure the interfaces related to PTZ control have been 
connected properly according to the specified PTZ mode.  

Address Code 

Sets the PTZ address code. 

Note: This item is configurable when the serial port mode is PTZ control and the PTZ 
protocol is not INTERNAL-PTZ.  

 

 

3. Click OK to save the above settings. 

 

Trans-Channel 

Transparent channels are used to transparently transmit data between two devices. 

Make sure the serial port mode of the device has been set to Trans-Channel, for detailed 
information, refer to Serial Port. 

 

 NOTE! 

Some devices don’t support the Trans-Channel Settings. For more information, refer to the web 
interface. 

 

Steps: 

1. Enter the Tans-Channel interface: 

Setup > Basic > Serial Port 

 
 

2. Configure the parameters as listed in the following table. 
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Configuration items Description 

Trans-Channel Enables/disables the transparent channel. 

Serial Port Name of the serial port to be set. 

Destination IP 
IP address of the third-party device connected to the transparent channel. 

Note: This item is configurable after the transparent channel is enabled. 

Destination Port 
Port number of the third-party device connected to the transparent channel. 

Note: This item is configurable after the transparent channel is enabled. 

Source IP Displays the IP address on the device side.  

 

3. Click OK to save the above settings. 
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7  Appendix- EZManager Introduction 

Description of EZManager 

EZManager, as one software of Uniview’s video surveillance managing software suite, integrates 
multi-functionality with not only live video viewing, network camera detecting and configuring, log 
administration and user information setting, but also the convenience of sequence displaying, 
multi-monitoring. It serves as a micro managing system, and enables you to detect online devices 
within your subnet and reveal the information of the devices. And with it, you can also modify the 
basic network setting of the devices. 

Detecting Devices Online 

Prior to detecting devices online via EZManager software, please make sure EZManager is correctly 
installed. After that, enter EZManager and do the following steps to detect devices online. 

 

 NOTE! 

The default user name of EZManager is “admin”, and password is “admin”. 

 

Steps: 

1. Access the Device Management interface. You can try either of the following two methods. 

a. Click Tool, and then select Devices in the drop-down list. 

 
 

b. Click  to enter home interface, and then click Device Management. 

1

2
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c. Click Search. Then, a Device Search box will be popped out. 

 
 

 

 NOTE! 

In this step, make sure Encoding device is selected in the Device list on the right of the Device 
Management interface. 

 

2. Click Auto Search. All the detected network cameras will be listed after a short period’s search.  

1

2
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Modifying Network Configuration 

Steps: 

1. Detect devices online. Please refer to the section of Detecting Devices Online in this User 
Manual for detailed information. 

2. Find the device to be modified in device list according to its Name, IP Address, Type or Serial 
Number labeled on the product. 

3. Right-click the selected device in device list, and then a drop-down list will be popped out.  

 
 

4. Click Modify Network Address on popped menu. A corresponding box will appear. 
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 NOTE! 

 The default gateway information you set must match IP address. 

 The administrator password is “admin” while default account is used. 

 

5. Modify the network parameters in corresponding setting blanks. 

Restoring Default Password 

Serial code is a must to restore the device to the default password. And it is a series of characters 
combined with the start time and the serial number of the device. To get it, contact your technical 
engineers. 

Steps： 

1. Detect devices online. Please refer to the section of Detecting Devices Online in this User 
Manual for detailed information. 

2. Find the device to be modified in device list according to its Name, IP Address, Type or Serial 
Number labeled on the product. 

3. Right-click the selected device in device list, and then a drop-down list will be popped out.  

 
 

4. Click Restore Device Password on popped menu. Then a relevant box will appear. 
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5. Input the serial code in the serial code field and click OK to restore the default password. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.uniview.com/en/ 

globalsupport@uniview.com 
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	2. Set the Occlusion Detection, Sensitivity and Duration parameters. Occlusion is easier to be detected with a higher value of Sensitivity (for example, A further/smaller occlusion may be detected in a high sensitivity). Alarm occurs when the lens is ...
	3. Configure the parameters as listed in the following table:
	4. Click OK to complete the configuration.


	Temperature Alarm
	Steps:
	1. Enter the Temperature Alarm interface:
	2. Configure the parameters as listed in the following table.
	3. Click OK to complete the configuration.


	Input Alarm
	Steps:
	1. Enter the Input Alarm interface:
	2. Configure the parameters as listed in the following table.
	3. Click OK to complete the configuration.


	Output Control
	Steps:
	1. Enter the Output Control interface:
	2.  Configure the parameters as listed in the following table.
	3. Click OK to complete the configuration.


	Audio Alarm
	Steps:
	1. Enter the Audio Alarm interface:
	2. Configure the parameters as listed in the following table.




	6   Others
	Maintenance
	Device Status
	Steps:
	1. Enter the Device Status interface
	2. View the device status.


	User Management
	Steps:
	1. Enter the User Management interface
	2. Select a user type. You can add an operator or modify the username and password for an operator. If you want to delete an operator, clear the username of the operator.
	3. Click OK to confirm the configuration.


	Device Maintenance
	Software Upgrade
	1. Enter the Device Maintenance interface
	2. In the Software Upgrade area, click Browse and select the upgrade folder where the upgrade files reside.
	3. Click Upgrade and click OK to launch the software upgrade process. The device will reboot automatically after the upgrade process completes.

	System Restart
	1. Enter the Device Maintenance interface
	2. In the System Restart area, click Restart and click OK.

	Config Management
	1. Enter the Device Maintenance interface
	2. In the Config Management area, select the configuration file by clicking Browse… in the Importing row and then to import the local configuration file. The system will prompt the result after the import process completes.
	3. To export the current configuration, click Browse in the Exporting row, set the path for saving the configuration file, and click Export.
	4. To restore the default configuration, click Default and then click OK. The device will then restart with the default configuration.

	Diagnosis Information
	1. Enter the Device Maintenance interface
	2. In the Diagnosis Info area, clicking Browse to select the path for saving the information and then click Download to save the diagnosis information as a file in the specified folder.



	Serial Port
	Steps:
	1. Enter the Serial Port interface:
	2. Configure the parameters as listed in the following table.
	3. Click OK to save the above settings.


	Trans-Channel
	Steps:
	1. Enter the Tans-Channel interface:
	2. Configure the parameters as listed in the following table.
	3. Click OK to save the above settings.



	7   Appendix- EZManager Introduction
	Description of EZManager
	Detecting Devices Online
	Steps:
	1. Access the Device Management interface. You can try either of the following two methods.
	a. Click Tool, and then select Devices in the drop-down list.
	b. Click / to enter home interface, and then click Device Management.
	c. Click Search. Then, a Device Search box will be popped out.

	2. Click Auto Search. All the detected network cameras will be listed after a short period’s search.


	Modifying Network Configuration
	Steps:
	1. Detect devices online. Please refer to the section of Detecting Devices Online in this User Manual for detailed information.
	2. Find the device to be modified in device list according to its Name, IP Address, Type or Serial Number labeled on the product.
	3. Right-click the selected device in device list, and then a drop-down list will be popped out.
	4. Click Modify Network Address on popped menu. A corresponding box will appear.
	5. Modify the network parameters in corresponding setting blanks.


	Restoring Default Password
	Steps：
	1. Detect devices online. Please refer to the section of Detecting Devices Online in this User Manual for detailed information.
	2. Find the device to be modified in device list according to its Name, IP Address, Type or Serial Number labeled on the product.
	3. Right-click the selected device in device list, and then a drop-down list will be popped out.
	4. Click Restore Device Password on popped menu. Then a relevant box will appear.
	5. Input the serial code in the serial code field and click OK to restore the default password.
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